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In1866, Elizabeth Cady Stanton was the first woman to run
for the U.S. House of Representatives, receiving 24 of the
12,000 votes that were cast.
In 1917, Jeannette Rankin, a Montana Republican, entered
the U.S. House of Representatives, the first woman ever
elected to Congress.
The 19th constitutional amendment was ratified three years
later, giving women the right to vote.
Edith Nourse Rogers, a Massachusetts Republican, served
in the House for 35 years (1925-1960), the longest tenure of
any woman.
Shirley Chisholm, a Democrat from New York, became the
first African-American woman to serve in the House of
Representatives in 1968.
Representative Ileana Ros-Lehtinen of Florida was the first
Hispanic-American woman elected to the House of
Representatives, in 1989.
Today, there are 78 women serving in the US House of
Representatives.

Sources: http://www.cawp.rutgers.edu/fast_facts/resources/Firsts.php &
http://womenincongress.house.gov/historical-data/women-of-color.html
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Seasonal Stress: It’s Never Too Late To Have A Stress-Free Holiday
By Cheryl Cusson
Director, Development Liaison Program
Regardless of your religious, cultural or family traditions, the holidays can be a time of joy with family and friends,
as well as a time of stress and anxiety. The following article is based on a conversation with Valerie Wedge,
LICSW, CEAP; Senior Consultant with the Employee Assistance Program at UMass Medical School. Valerie
points out some of the key seasonal stressors and how we can manage them to ensure a healthy, stress-free
holiday.
Unmet expectations are a key factor for holiday stress, according to Valerie. People have high expectations of
gatherings with family and friends, gift giving and time off from work. Stress occurs when unmet expectations
arise within the social, financial and familial contexts of our lives. Valerie believes that financial concerns are the
largest source of stress reported over the past several years. Women want to be able to uphold the traditions that
they have been accustomed to, but they may not be able to afford them.
Today social boundaries are looser and people are more open, which can become a problem at the seasonal
office party. Too much alcohol can lead to acting in inappropriate ways. What you thought may be a happy time
of camaraderie and celebration, may end up creating more stress long after the holidays have passed.
Being a caregiver of a parent, or having college-age children returning home or young children out of school for a
week also adds stress for working women. Finding quality one-on-one time with loved ones and scheduling fun
activities can be stressful, especially for the working parent. Finally, grieving the loss of a child or parent is always
difficult during the holidays. Families have to rethink their traditions as they deal with their grief and the transition.
Valerie suggests some simple tips to keep the joy alive.
 Consider that the holidays are a temporary situation that is time limited.
 Stick to your routine. If you exercise, jog, do yoga, or meditate keep doing it.
 Get your sleep.
 Select social events carefully. Attend the ones that have the most meaning for you.
 Be mindful of what you put into your body and of your alcohol consumption, especially at parties attended
by your boss or supervisor.
 Stay organized; use your to-do list.
 Have a budget and stick to it.
 Create new traditions for the season and weave in the old traditions.
 Big families may want to adopt a holiday gift exchange, Yankee swap or grab bags with an agreed upon
budget.
 Avoid the lines at the store. Shop online for bargains and research product reviews.
 When shopping for teens or young adults, get their list - a description of exactly what they want along with
the link where you can purchase it.
 Take a 5-minute relaxation break. Take a walk, stargaze, or listen to soothing music.
 If grieving the loss of a family member, consider creating a new ritual for the holidays, such as going
somewhere different as a family, taking a nature walk, planning a memory garden.
 Reach out - don’t let yourself become isolated from others.
 Seek professional help if you need it.
Overall, it’s all about nurturing yourself, keeping a positive attitude, knowing your limits and not sweating the small
stuff. It’s never too late to have a stress-free holiday – enjoy!
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Technology Corner
UMMS’ Business Product Analysis, Implementation and Web
Services
By Henrietta Ford, Customer Services Center Manager, Information Services
Are you currently using tools or applications within your department that are outdated or no longer meeting your
department or business needs? Are you considering an upgrade or looking at implementing a new tool or
application but are not sure where to start? Have you considered implementing a webpage for your department or
project? Did you know that the UMMS Information Services Department can assist you every step of the way with
each of these tasks? Here is what Information Services has to offer you!
Scope Development:
Information Services staff are skilled at leading the process of scoping product, business and service requirements
and making recommendations to implement and maintain cost effective solutions for your department. A project’s
scope typically evolves and improves during the project planning process. Consequentially, the pre-planning
project team should submit design and scope packages for approval in multiple stages. This allows decision
makers to make educated and rational decisions.
Scope Development may include:
Business Opportunity Definition • System Workflow Documentation • System Requirements Definition
Product and Vendor Evaluation • Quality Assurance Recommendations
Application & Database Development:
Increased competition and dynamic markets require businesses to stay nimble and at optimal performance.
Information Services develops dynamic forward thinking solutions to meet many needs and requests utilizing for
front development technologies such as: Java J2EE, .NET, Oracle and MS SQL Server. Information Services also
provides enhanced functionality to the user base in the form of commercial products such as: Ektron Content and
Document Management Systems and Adobe Connect communication/collaboration/training tools.
Application/Database Development may include:
Technology Evaluation • Application Design • Development & Support • Web-enabled Solutions
Product Architecture Design & Standards • Database Design & Administration • Integration Services
Quality Assurance • Web Site Development and Hosting • Third Party Application Acquisition
Web Services:
Information Services is pleased to provide a full-service web site for the UMMS community. UMMS websites
follow the University of Massachusetts Medical School Visual Identity Program and they can be implemented on
the public domain (www.umassmed.edu) or on the intranet (inside.umassmed.edu). The web services team's
expertise will help define the information architecture for your site, improve the search capabilities, and provide
tools for monitoring your site.
Enterprise Survey Tool:
Feedback Server is an enterprise wide, web-based survey software solution that allows users to easily create,
manage and deploy web based surveys throughout the UMMS organization and targeted communities. This
product allows you to easily prepare and distribute surveys, gather responses, export data, and analyze and report
on important feedback from your customers, employees, students and website visitors.
For more information on any of these services, please contact the UMMS IS Help Desk at 508-856-6843 or
umwhelpdesk@umassmed.edu. The Help Desk will get you in contact with the correct support group that can
assist in answering any questions you may have.
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Women, Depression, and UMass Medicine
By Kim Canty
Director, Individual Giving, UMMS/UMass Memorial Development Office
Everyone feels a little sad now and then. Many artists have written songs about “the blues.” Like the music, the
sadness is usually fleeting and gone in a couple of days. But when a woman has a depressive disorder, it interferes
with daily life and normal functioning, and causes pain for both the woman with the disorder and those who care
about her. According to the National Institute of Mental Health, women are 70% more likely than men to experience
depression in their lifetime. Anyone who is experiencing symptoms of depression should speak with their primary
care physician to determine how to move forward with treatment.
Some symptoms of depression in women:
 a persistent sad, anxious, or "empty" mood
 thoughts of death or suicide, or suicide attempts
 difficulty concentrating, remembering, or making decisions
 loss of interest or pleasure in activities
 feelings of guilt, worthlessness, helplessness, hopelessness, pessimism
 restlessness, irritability, or excessive crying
 decreased energy, fatigue, feeling "slowed down"
 sleeping too much or too little, early-morning awakening
 appetite and/or weight loss, or overeating and weight gain
 persistent physical symptoms that do not respond to treatment, such as headaches, digestive disorders, and
chronic pain
No one understands depression better than our colleague Kristina M. Deligiannidis, MD, who serves as Medical
Director of the The Depression Specialty Clinic (DSC) at UMass Memorial Medical Center. The mission of the DSC
is to provide excellence in consultative clinical care for individuals with depression and provide a platform for training
of UMMMC faculty, staff and trainees. Additionally, Dr. Deligiannidis evaluates and treats women in the Women’s
Mental Health Specialty Clinic at UMMHC. As impressive as her clinical skills is her long list of representative
publications and her nationally recognized research efforts. And she is counted among the alumni of our very own
medical school! To learn more about Dr. Deligiannidis check out this link:
http://www.umassmed.edu/Psychiatry/Depression_Specialty_Clinic-Kristina_M_Deligiannidis_MD.aspx
While some experts believe that the increased chance of depression in women may be related to changes in
hormone levels that occur throughout a woman's life, some research shows a strong relationship between eating
disorders (anorexia and bulimia nervosa) and depression in women. For Sherry Pagoto, PhD, associate professor
of medicine at the medical school and a licensed clinical psychologist at the UMass Memorial Weight Center, the
focus has been on obesity and depression. Both are challenging health issues for women that can be even more
difficult when they must be treated together.
Earlier this year, the UMMS Women’s Faculty Committee invited Dr. Pagoto to be its 2012 Women’s Health
Speaker. Her talk “Obesity and Depression: From the clinic to the science . . . and back” highlighted the findings of
her National Institute of Mental Health-funded study, Treating Co-Morbid Obesity and Major Depressive Disorder, a
randomized clinical trial that examined whether treating depression first could improve weight-loss outcomes of 154
overweight women with major depressive disorder. Results showed that the women who improved in their
depression were able to lose clinically significant weight, while those whose depression did not improve did not lose
weight. For more information about Dr. Pagoto and her research, go to:
http://www.umassmed.edu/news/2012/research/womens-health-pagoto-obesity-depression.aspx
According to the World Health Organization, the disease that robs the most adults of the most years of productive
life is not AIDS, not heart disease, and not cancer. It is depression. While there is much more to do, we should be
proud that our esteemed colleagues at UMMS and UMMHC are working together to catalyze our world-class basic
research into scientific discoveries and translate knowledge into clinical practice.
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The Empty Nest
By Barbara Gilmartin, Project Coordinator, Center for Health Policy & Research
Sometimes the hardest part of being a mother is letting go. On the first day of school I held my daughter’s hand as
we walked into her classroom. Before we even got inside, she starting trying to pull away to go meet her new
friends. I clutched her little hand as tightly as I could, but eventually she broke free and ran off smiling ear to ear.
The experience the year before with my son was very different. He didn’t want to go, and wouldn’t let go of my
hand until I gently pried it out of mine and assured him that everything would be fine. Both times I choked back
tears as I turned to leave.
In what seemed like a nanosecond, the years flew by and I found myself sending them off to college. My daughter
was the last one to leave the nest. After a long day of moving her into her dorm, finally it was time to go. I held her
hands tightly in mine as I said goodbye, and once again I felt her pulling away. This time there was no turning and
choking back tears, they fell uncontrollably as my daughter gently pried my hands from hers and assured me that
everything would be fine.
Every year, millions of parents send their children off to college and
experience the same emotions. They hug, they cry, and then they go
back home to an empty nest. Even though they’re not gone for good
yet, their lives will never be the same. For married couples who have
been focused for so many years on being parents adjusting to life
without children in the house can be difficult. Over the past two
decades divorce rates for couples over the age of 50 have doubled, and
some of these divorces are couples who find that their children were the
glue that kept them together. For many others however, just the
opposite is true. According to a study in 2008 by the University of
California at Berkeley, marital satisfaction improved for women after
their children left home. Many couples report that their marriages are
stronger than ever once it’s just the two of them again.
Single mothers face their own challenges, as I can attest to firsthand. The nest is especially empty when you have
to come home and face it all alone. For a short time you may wander from room to room, listening to the silence
and feeling the emptiness, but fortunately this doesn’t last forever. The first day that you come home from work and
realize that the house is exactly as you left it in the morning and that you don’t need to cook dinner or do laundry for
anyone but yourself does wonders to fill the void.
For mothers still struggling with the pain of an empty nest, take heart. According to a recent Harris poll, 40% of
adults aged 18 – 39 are currently living at home or have done so in the recent past. The odds of your child never
coming back once they leave for college are pretty slim. After my daughter finished college, she lived in England
for 5 years. Not only did I cry when I put her on the plane, I cried every time she went back after a visit. Eventually
she moved back to the U.S. with her British husband and they temporarily lived with me until they found their own
place. My son, who had been out on his own for many years, recently moved back in with me this spring after he
lost his job. It’s been an adjustment for both of us, but I’m happy that I can be here to help him out, and we’ve
enjoyed reconnecting and spending time together. The best part is that I had someone to mow my lawn all
summer.
Regardless of how often your children may boomerang back home, sending them off on their own and adjusting to
an empty nest is a rite of passage for every mother. Someday my daughter will cling tightly to a little hand herself
and have to let go, and then she will learn, just as I did, and just as my mother did before me, that sometimes the
hardest part of being a mother is letting go.
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Professional Women Connect
Computer & Software Tips
Compiled by Laura Sefton, Research Coordinator, Center for Health Policy and Research
In the summer issue of the newsletter, the Readers’ Poll asked for your computer and software tips. Your tips and
tricks are below. Thank you for your responses!
General tip for PC Users:
 To toggle between applications, such as a Microsoft PowerPoint presentation and a web browser, press the
Alt and Tab keys at the same time. You’ll see the program icons in the center of your screen. If you have two
computer monitors, press the Windows key (bottom left side of the keyboard, between the Control and Alt
keys) and the Tab key at the same time to see your open applications.
Tips for Microsoft Outlook Users:
 To quickly attach a file to an Outlook email, left click on the file name in Windows Explorer, then drag the file
to your email while continuing to hold the left button down.
Tips for Microsoft Word Users:
 Change the initials that appear in each comment (New Comment function on the Review toolbar) by going to
the File menu, choosing Options, and then choosing General. Under “Personalize Your Copy of Microsoft
Office,” edit what appears in the Initials box. This way, in a document being edited by more than one person,
everyone will know whose owns each comment.
 To keep all the lines of a paragraph together, right click your mouse to access the Format menu, click
Paragraph, and then click the Line and Page Breaks tab. Select the ‘Keep lines together’ check box under the
Pagination selections. To keep the first or last lines of a paragraph from appearing on a separate page, check
the Widow/Orphan control box under the Pagination selections.
 To select text vertically rather than horizontally (i.e., multiple tabbed columns of text), press the Alt key before
left clicking and dragging your mouse to highlight the text.
 To view two consecutive pages of the same document at the same time, resize the document to 80% so both
pages show side by side on the screen using the zoom slider at the bottom right hand side of the screen.
Tips for Microsoft Excel Users:
 The sideways M symbol, or sigma, in the Home tab tool bar, gives you the ability to sum a column or row of
numbers together, or find their average, minimum, or maximum. Highlight the cells with the numbers you want
to sum, and then click the sideways M to add them together. The sum will appear in a cell after the last
number in the group. Click the down arrow just below the sideways M to access its other functions.
 When sorting in Excel, remember to click the My Data Has Headers check box in the Sort pop-up to see the
column names you’ve assigned rather than the generic column letters. If you want your data to sort by letter
case (lower case versus upper case letters), click Options in the Sort pop-up box, and check “Case sensitive”.
 To edit a cell that contains a hyperlink (without opening the hyperlink), left click and hold the left mouse button
down until the hand icon changes to a cross, then proceed with editing.
 If you want to edit something in a cell but don’t want to delete the entire content of the cell, click on the cell,
then press the F2 key. This will allow you to add text or numbers without deleting the entire cell.
Tip for Windows Explorer Users:
 If you have a shared drive on the UMMS network, you can retrieve a document that was recently deleted or
restore an old version of one. To do this, right click on the folder name where the document was most recently
located, and right click your mouse. In the menu that pops up, choose “Restore previous versions.” This will
bring up a list of previous versions by date. Double click the folder dated prior to the deletion or revision. This
will bring up another Explorer window. Copy/paste or drag the document to your current Explorer window.
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The Gathering Place
Readers may find the resources below helpful:
The UMMS Employee Assistance Program (EAP) is a resource available to the UMMS community. It is a free
and confidential service providing a range of personal assistance such as counseling, consultation, assessment,
intervention, information and referral to employees and their household members. Issues can be individual, family,
or work-related. Contact UMMS’ EAP office at 800-322-5327 to speak directly to a licensed counselor or visit their
website for more information at http://www.umassmed.edu/eap/index.aspx?linkidentifier=id&itemid=41820
Mass 2-1-1 is a service that connects Massachusetts residents with needed community services. It is free,
confidential, multilingual, and available 24/7. They provide information about available services such as child care,
after-school programs, elder services, counseling, food, shelter, and emergency services. Dial 2-1-1 or 1-877-211MASS (6277) to speak to a trained specialist. Visit their website for more information: http://www.mass211.org/.
American Consumer Credit Counseling is a non-profit organization that provides credit counseling, debt
management services, home buying education, and personal money management guidance. Their online ‘Fitness
Center’ has a variety of financial literacy tools. See their website at http://www.consumercredit.com/index.html.
UMMS’ own UMassFive College Federal Credit Union (https://www.umassfive.coop/) holds financial literacy
seminars several times a year at various branches, including the UMMS campus. Their web-based resource center
has information about credit/debit cards, identity theft, kids & money, and car buying, and provides tip sheets,
worksheets, and calculators.

PWC Bookshelf
The Professional Women’s Committee has purchased
a number of books available for borrowing from the
Lamar Soutter Library. Topics range from career
advice to skill-building. For a complete list of
publications, visit Professional Women’s Committee
website or contact the newsletter.

Generating Momentum is published in 3 times a
year, in Spring, Summer, and Fall. Your ideas,
opinions, and concerns are always welcome, so let us
hear from you.
To view copies of previous newsletters, please visit
the Professional Women’s Committee website or
contact the newsletter.

PWC Website
Professional Women’s Committee
The Committee meets on the 2nd Thursday of every
month from 3:30-4:30PM. Upcoming meetings are
scheduled for December 13th, January 10th, and
February 14th. Meetings are held in the Italy
Conference Room on the South Street campus and
can be attended via conference call from any location.
All professional women are encouraged to attend and
participate in the ongoing activities of the Committee.

http://www.umassmed.edu/Content.aspx?id=61984&linkide
ntifier=id&itemid=61984

Editor
Laura Sefton | Laura.Sefton@umassmed.edu
Newsletter mailbox | PWCNewsletter@umassmed.edu
HU

Camera Crew
Bhavna Bhatia, Lopa Dahl, Lena DeSantis Riccardi,
Heather-Lyn Haley, Susanna Perkins
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